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MagBytes; the fine print 
This is a free New Zealand subscriber email info magazine from the NZ Apple news and info site mac-nz.com.
MagBytes tells you what’s happening and what’s new in the world of Apple every month, compiled from Mac NZ. 
Learn tips and how to do interesting things with your Macs and iDevices, and how to get more out of them. 
MagBytes is brought to you by Mark Webster, onetime editor of NZ Macguide magazine and a long-time trainer and commentator on Apple and the world of technology. 
Mark wrote about Apple for a worldwide audience on the New Zealand Herald under the title ‘Apple Watch’ (2009-2014) and at his Mac NZ Apple info site for New Zealand. You can store 
your issues of MagBytes on your HD, Thumb Drive or on CD/DVD, read it on screen, or even just drag it to iTunes (or to iBooks, from macOS 10 Mavericks onwards, which means you end up 
with a reference library you can search, highlight, add notes to etc) and have it appear on your iPhone and iPad (inside iBooks) next time you sync. Or print it out, even – and please feel free 
to pass MagBytes on. MagBytes is free to receive and you can opt out any time by sending an email here with ‘opt out’ in the subject line. The email list is guarded and private and held by 
Mac NZ for this purpose only. Find out more about the MagBytes Apple newsletter online (click on ‘MagBytes Newsletter’ at top right).

February 2017  
•2——Mac News ~ Microsoft 

Office gets Touch Bar support, 
Sydney Store bomb threat, wifi 

power, WWDC for San Jose, 
admiration, VR, Mac SE, Apple 
Pro apps’ in education bundle  

•4——Updates ~ Sound Source, 
GarageBand, LG, Sonnet, 

Luminar, Logic, Remote Desktop 
•6——Mac Help ~  

Around New Zealand 
•7—— iOS & iDevice news ~ iPad 

Pro, iPhone 7+ Billboard, travel 
apps, Warhammer, Siri, night ads 

•9——Apple & Talk ~  
1984, & Not on my watch 
•11——Tips & Tricks ~  

iOS and Siri, EarPods, Photo 
Markup, zoom, macOS Finder 

•16——Shiny & New ~ 
Editors Keys, new Norton 

protects everything, plus better 
photography for just 99¢

Monthly NZ newsletter of  things Apple for your edification and delectationMagBytes

A new book for only 99¢ tells you how to use iPads and iPhones to take wonderful photographs

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.creativetech.net.nz
http://www.mac-nz.com
http://www.mac-nz.com
mailto:newsletter%40mac-nz.com?subject=Opt%20Out
http://www.mac-nz.com
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Mac News > Office Touch Bar ~ Aussie bomb ~ Wireless Power ~ WWDC San Jose

MacBook Pro Touch Bar support in Office 
Following after a brief beta preview, Microsoft is 
rolling out support for the MacBook Pro Touch Bar to 
all users of Office for Mac, with the update providing 
quick access to functions from the new dynamic 
display panel.
For Word, MacBook Pro users gain a ‘Word Focus’ 
mode which hides all onscreen ribbons and commands 
on the main display, to help users focus on their work. 
Formatting tools are instead displayed on the Touch 
Bar, keeping them available to use, but not distracting 
the user.

Bomb threat in Australian Apple Store
Apple’s flagship Australian store was briefly evacuated 
mid-day on Friday 18th, in what appears to have been a 
response to a bomb threat.
The three-floor Sydney outlet, located on George 
Street, was cleared out just prior to 1pm local time “as 
a precaution” during a “police operation,” according to 
a spokesperson for the police.

Apple in the Wireless Power Consortium
While the news of Apple joining the Wireless Power 
Consortium doesn’t offer absolute clarity of Apple’s 
future plans (besides hinting that the next iPhone will 
support wireless charging), it does reveal some things 
to the wireless power industry as a whole.

28th annual WWDC to be in San Jose
At McEnery Convention Center in San Jose, to be 
exact. The conference, kicking off 5 June, will inspire 

61 Hurstmere Road, Takapuna 09 486 1493

Authorised to service iPod, 
iPad and Mac

www.istorenz.com

Enhancing Your Apple Experience

Scan QR Code to quickly 
get in touch with iStore

More news is online at Mac NZ

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://appleinsider.com/articles/17/02/16/microsoft-rolls-out-macbook-pro-touch-bar-support-to-all-office-for-mac-suite-users
http://appleinsider.com/articles/17/02/16/microsoft-rolls-out-macbook-pro-touch-bar-support-to-all-office-for-mac-suite-users
http://appleinsider.com/articles/17/02/17/bomb-threat-forces-evacuation-of-apples-flagship-australian-store
https://www.appleworld.today/blog/2017/2/18/some-implications-of-apple-joining-the-wireless-power-consortium
https://www.macobserver.com/news/wwdc-2017-june-5-9-moves-to-san-jose
http://www.istorenz.com
http://www.mac-nz.com
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Mac News > Most Admired ~ VR Desktop ~ Mac SE ~ Pro Education discount

developers from all walks of life to 
turn their passions into the next great 
innovations and apps that customers 
use every day across iPhone, iPad, Apple 
Watch, Apple TV and Mac.
Since 2003 it has been held at Moscone 
West in San Francisco.

World’s Most Admired company
Every year, Fortune puts together a survey 
of corporate reputations called The 
World’s Most Admired Companies. This 
year, Apple leads the list.

Cindori’s VR Desktop for Mac
Cindori has introduced VR Desktop, a 
US$19.99 app that lets you use macOS 
together with Virtual Reality (VR) 
headsets. It requires macOS 10.11 or later 
and Oculus Rift DK2.
For now VR Desktop only works with the 
Oculus Rift dev kit (DK2). However, Cindori 
plans to support other VR headsets.

30-Year-Old Mac SE revived
British Tech Network host Ewen Rankin 
took his 30 year old Mac SE prototype to 

a Genius Bar at an 
Apple Store. With 
the help of friends 
he got a of Mac OS 
System 3.3 on floppy 
disks – the operating 
system the SE 
originally shipped 
with – and then 
made his way to the 
Apple Store.
The geniuses were 
more than happy 
to help out even 
though the Mac was 
older than some of 
them, and in the end 
they got it up and 
running.

Pro Apps for Ed 
Educators and 
students rejoice! 
Apple’s heavily-
discounted Pro 
Apps Bundle for 
Education is now 
available in over 
30 more countries 
around the world, 
including New 
Zealand. 

More news is online at Mac NZ

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.appleworld.today/blog/2017/2/16/apple-is-fortunes-2017-worlds-most-admired-company
https://www.appleworld.today/blog/2017/2/13/cindoris-vr-desktop-lets-you-use-a-mac-with-some-vr-headsets
http://www.macsense.co.nz
https://www.macobserver.com/cool-stuff-found/genius-bar-revives-30-year-old-mac-se
https://www.macobserver.com/cool-stuff-found/genius-bar-revives-30-year-old-mac-se
http://www.apple.com/nz-hed/shop/product/BMGE2Z/A/pro-apps-bundle-for-education
http://www.apple.com/nz-hed/shop/product/BMGE2Z/A/pro-apps-bundle-for-education
http://www.mac-nz.com
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Revamped SoundSource 3.0.0
This app brings quick audio source & output switching back 
to Mac after 5-year hiatus — A pair of old OS X audio routing 
applications have regenerated, and have merged to form the new 
SoundSource 3.0.0 by Rogue Amoeba —and AppleInsider takes a 
look at the offering.

GarageBand update to 10.1.6 patches exploit
Hidden in the Mac App Store updates tab the past day or two 
has been an update for GarageBand to version 10.1.6. While the 
update notes state that the new code is to fix “Performance and 
security issues”, it appears that the primary reason was to shut 
the door on a vulnerability in GarageBand.
Opening a “maliciously crafted” GarageBand project file could 
cause “arbitrary code execution”.  [So take note: you have to open a 
GarageBand file someone sends you to be vulnerable.]

Logic Pro X 10.3.1
Apple has released Logic Pro X 10.3.1. The update includes a 
security fix for maliciously crafted GarageBand files. It also 
improves the way regions perform, edits, and the ability to share 
44.1kHz projects to GarageBand for iOS.

Thunderbolt 3 adapters
Sonnet Technologies has announced Mac 
compatible Twin 10G Thunderbolt 3 Edition 
Thunderbolt 3 to Dual-Port 10GBASE-T 10 
Gigabit Ethernet (10GbE) adapter, and the Twin 
10G SFP+ Thunderbolt 3 Edition Thunderbolt 3 
to Dual-Port SFP+ 10GbE adapter. 
These will be available in New Zealand through 
MacSense.

Updates > SoundSource ~ GarageBand ~ UtraRough ~ Sonnet 10GbE ~ Luminar

Troubled UltraFine 5K display 
This will only add to cries that Apple 
once again start making its own external 
displays for use with Mac laptops: the tech 
giant has stopped sales of LG’s UltraFine 
5K monitor after delays and problems. 
The latest problems are associated with 
a lack of proper shielding from wireless 
interference. Apple retail staff were 
apparently told to keep the product on 
display yet not sell any units ... 

Luminar update
Luminar, the software that sensationalises 
pretty much any photo, has an update 
which adds support for Photoshop smart 
objects and actions, improved batch 
processing, better crop angles, enhanced 
colour temperature filter plus speed 
improvements and a rotate tool. 
If you already have Luminar, launch it, click 
the Luminar men and select Check For 

Updates. 

Apple Remote 
Desktop 3.9
This update adds support 
for the Mac Book Pro’s 
Touch Bar and features 
the ability to export 
computer lists, while 
improving security.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.appleworld.today/blog/2017/2/15/garageband-update-to-1016-patches-potentially-malicious-exploit
https://www.appleworld.today/blog/2017/2/15/garageband-update-to-1016-patches-potentially-malicious-exploit
https://www.macobserver.com/news/product-news/apple-releases-logic-pro-x-10-3-1-security-fix-improved-regions-ios-garageband-support
https://www.appleworld.today/blog/2017/2/13/apple-temporarily-stops-sales-of-lgs-ultrafine-5k-display
https://www.appleworld.today/blog/2017/2/13/apple-temporarily-stops-sales-of-lgs-ultrafine-5k-display
https://www.macobserver.com/news/product-news/apple-remote-desktop-updated-touch-bar-support
http://www.macsense.co.nz
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U S B - C  t o  U S B  C a b l e
Power and charge any USB-C device (ie, MacBook, late 2016 
MacBook Pro) using a regular USB charger. Supports USB 3.1 
Gen 1 data transfer speeds of up to 5 Gbps, Moshi’s USB-C 
to USB Cable is encased in aluminium with reinforced stress 
relief points and includes a HandyStrap cable manager
NZ RRP$44.99

I o n G l a s s  f o r 
i P h o n e  7
IonGlass is an atomically-
strengthened glass screen 
protector featuring 
smooth, edge-to-edge 
protection with a micro-
bevel around the Home 
button for fast unlocking 
via Touch ID. Its exceptional 
hardness exceeds that of 
steel. 
NZ RRP$59.99 
(iPhone 7 Plus, NZ$69.99)

U S B - C  t o  V G A  a d a p t e r
Output HD video from any USB-C device or laptop 
to a VGA display or projector. Moshi’s VGA adapter 
supports video resolution up to 1920 x 1200/1080p 
at 60Hz. Both ends of the cable are encased in 
anodised aluminium to minimise electromagnetic 
interference. With its reversible USB-C connector 
and plug-n-play capability, the adapter guarantees a 
hassle-free setup for convenient home or office use
NZ RRP$69.99

U S B - C  C h a r g e  C a b l e
Smart LED indicators keep track of your charging 
status. Supporting up to 60 Watts of power output 
and USB 2 data transfer speeds, Moshi’s USB-C 
Charge Cable has durable aluminium housings and 
delivers utility and style for anyone with an Apple 
Retina MacBook, Google Chromebook Pixel, or 
any mobile device equipped with a USB-C port. At 
2 metres length (6.6 feet) in length, a HandyStrap 
is also included to keep your cable neat and tidy 
during transport 
NZ RRP$59.99

a r m o u r  f o r  i P h o n e 
6 -7
The armour features a 
diamond-cut aluminium 
backplate with a unique 
metallic finish, the 
hybrid material has 
shock absorption and is 
scratch resistant. It has 
fully-encased volume and 
power buttons and the 
raised bezel protects the 
display and the case offers 
military-grade drop-
protection (MIL-STD-810G, 
SGS-certified)
NZ RRP$64.99

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-usb-cable-1m
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-usb-cable-1m
https://www.macgear.co.nz/collections/moshi/products/moshi-ion-glass-for-iphone-7-plus
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-to-vga-adaptor
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-charge-cable-2m-1
https://www.macgear.co.nz/collections/moshi/products/moshi-usb-c-charge-cable-2m-1
https://www.macgear.co.nz/collections/moshi/products/moshi-iglaze-armour-for-iphone-7
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Apple’s official support pages are 
comprehensive and cover all aspects of 
Apple hardware and software – it’s here.
Also try Intro to the Mac and How Tos.
AppleCare: If you need your Mac fixed, 
look for an Apple licenced repair centre. 
People often ask me if they should buy 
AppleCare with their devices. Every new 
Mac has a one-year warranty and 90 days 
free phone support. AppleCare extends 
this all out to three years. Under NZ 
law, you are covered by the Consumer 
Guarantees Act against anything going 
wrong that comes down to parts failure 
within reasonable expectations (say, inside 
three years’ use), but be prepared to spend 
anxious time on the phone, sticking to 
your guns to get it fixed. 
However, this absolutely does pay off.
AppleCare is expensive, depending on the 
device, but it’s a replacement policy which 
covers you anywhere in the world. 
If you travel and you want full reassurance, 
and you can afford it, AppleCare is superb.

Mac Senior Net — ready to help
If you are aged 55 years or better and you 
use an Apple computer or device, Mac 
Senior Net is a wonderful resource.

Christchurch: With nearly 600 
members, this very active Apple-
focussed group covers Christchurch with 
a dedicated lab – and caters to the city’s 
surrounds by running iPad sessions in 
rest homes. This is a large, well-run and 
successful group.
 
Auckland: Mac Senior Net Auckland 
provides on-going Apple Mac and iDevice 
knowledge to help competency, learnt 
alongside others in similar situations. 
The Auckland Club holds monthly 
meetings in Howick, Bayswater and 
Remuera and provides lessons and talks 
very reasonably. Go to MSN Ak’s web page 
or email Marion Moffat.
Handy Absolute Beginners’ courses are also 
available at SeniorNet, including for iPads.
Eden Roskill — This Auckland branch has 
an Apple Group that meets on the second 
Monday of every month at 487 Dominion 
Rd in the Mt Eden Senior Citizen Rooms, 
opposite Potter’s Park in Balmoral. There 
are several courses for Apple users (Mac, 
iPhone and iPad) as numbers warrant. To 
join, call Janet 09 828 3098

Mac & iDevice training in 
Auckland 
You’re getting MagBytes and may be 
following my weekly Friday tips on Mac NZ 
– but I sometimes run Grey Lynn Sessions 
in Auckland (click on Training). This is the 
cheapest way to learn, at $40 per session 
in a friendly, group environment. 
Please email if you are interested in 
attending, as I only book a room when I 
can guarantee five attendees. 
The sessions are friendly, open to 
questions at all times and are backed up by 
‘tip sheet’ handouts. 
I can and do train one-to-one or to small 
groups at your home or workplace in 
Auckland. This costs $95/hour. 
I can present to institutions on Mac and 
iDevice: tips, tricks, hidden features, 
demystification ...Email Mark for info.

Mac diagnostics
Your Mac has various diagnostic tools and 
routines available. If you think things are 
going awry, check the Help page on Mac 
NZ (click on Help at the top).

Mac help in the North 
Dave Boswell has been a reseller in 
Whangarei for 20 years and can assist. 
MacNorth Computers 09 433 9855,  
027 490 2332, or email Dave Boswell.

Mac Help > Apple assistance, Consumer Guarantees Act, help, support

Papakura — Mac Interest Group meets 
every 1st, 3rd and 4th week of the month 
9.30 to Noon. An iPad Interest Group 
meets every 3rd Tuesday at 1pm
An “Introduction to iPad” course run on 
demand.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.apple.com/support/
http://www.apple.com/nz/findouthow/mac/
http://www.apple.com/nz/findouthow/mac/
http://www.apple.com/nz/service/
http://www.consumeraffairs.govt.nz/for-consumers/law/consumer-guarantees-act
http://www.consumeraffairs.govt.nz/for-consumers/law/consumer-guarantees-act
http://www.apple.com/nz/support/products/mac.html
http://www.seniormac.org.nz
http://www.seniormac.org.nz
http://www.macsnrs.org.nz
mailto:%20macseniorauckland%40mail.com?subject=Enquiry%20via%20MagBytes%20about%20SeniorNet
http://www.seniornet-eden-roskill.org.nz
https://macnzmark.wordpress.com/training/classes-in-grey-lynn/
mailto:mac.nz%40mac.com?subject=Grey%20Lynn%20sessions
https://macnzmark.wordpress.com/training/one-to-one-visits/
https://macnzmark.wordpress.com/training/business-corporate-academic/
mailto:mac.nz%40mac.com?subject=Please%20tell%20me%20more%20about%20training
http://www.mac-nz.com/help_.html
http://www.mac-nz.com/help_.html
mailto:Dave%20Boswell%20%3Cdaveboz%40xtra.co.nz%3E?subject=Query%20from%20MagBytes
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iDevice news

Logitech ad

iPad Pro ads
Apple has released four new 
commercials for the iPad Pro, 
coming amidst several rumours that 
the company is planning to update 
the iPad lineup within a matter of 
months. [Apple likes to diminish stock 
of outgoing models. Of course, once 
a new model arrives, you can get the 
outgoing ones at discounts …]
Each of the spots is in response a 
Twitter post, and make a different 
claim about the tablet. Three 
of these compare the Pro with a 
computer, noting for instance that 
it can run Microsoft Word, yet 
doesn’t get PC viruses.

Billboard iPhone 7+ cover
The cover of the latest issue of 
Billboard Magazine – showing Fifth 
Harmony singer Camila Cabello 
– was shot on an iPhone 7 Plus at 
the request of the magazine. The 
photographer normally relies on 

> iPad Pro ~  iPhone 7+ shoots the Billboard Magazine cover

More news is online at Mac NZ

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://appleinsider.com/articles/17/02/17/apple-launches-new-series-of-ipad-pro-ads-as-anticipated-hardware-refresh-looms
http://appleinsider.com/articles/17/02/17/apple-launches-new-series-of-ipad-pro-ads-as-anticipated-hardware-refresh-looms
http://appleinsider.com/articles/17/02/16/new-billboard-cover-features-photo-shot-with-apples-iphone-7-plus
http://www.logitech.com/en-nz/tablet-accessories?WT.ac=HP-footer-tablet-accessories
http://www.mac-nz.com
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iDevice news> Travel Apps ~ Warhammer 40,000 ~ Siri vs Alexa ~ Global night

high-level professional gear, such as a 
Mamiya 645DF+ medium-format camera 
or a Canon 5D Mark III, supplemented 
by other tools such as lighting systems. 
The 645DF+ alone costs about US$5000 
with a single 80-millimeter lens, whereas 
an iPhone 7 Plus starts at US$769. The 
iPhone 7 Plus is Apple’s first device with a 
dual-lens camera, which enables its special 
Portrait mode.

Best travel apps
Apps that are good to either install or 
familiarise yourself with prior to your 
departure, including for cruises.

Best Warhammer 40,000 games
There are dozens of Warhammer 40,000 
games available for iOS, but which are the 
must-plays? AppleInsider examines them 
to purge the heretical ones.

Apple’s Siri vs Amazon’s Alexa
Microsoft has Cortana Artificial 
Intelligence and Google has Assistant. On 
your iOS and tvOS devices, we have Siri. 

If you’re an Amazon fan, Alexa 
is present in the Echo, Echo Dot, 
Fire TV and Amazon Tap. All of 
these are very capable virtual 
assistants, but Siri and Alexa 
seem to dominate the artificial 
intelligence landscape for many 
of us. 
So which is more intelligent?

iPhone globally  
at the top again 
Global sales of smartphones 
totalled 432 million units in the fourth 
quarter of 2016, a 7% increase over the 
fourth quarter of 2015, according to 
Gartner, Inc. The fourth quarter of 2016 
saw Apple leapfrog past Samsung to 
secure the number one global smartphone 
vendor position, notes the research group.
In 2016 overall, smartphone sales to end 
users totalled nearly 1.5 billion units, an 
increase of 5% from 2015. It’s taken eight 
quarters for Apple to regain the No. 1 
global smartphone vendor ranking, but 
the positions of it and Samsung have never 

More news is online at Mac NZ

been so close, with only 256,000 units 
difference.

iPhone night photography tips
Whether you want to shoot the stars 
or capture the mysterious, romantic, 
or magical feeling of a scene at night, 
there are tricks to the trade. Taking great 
pictures at night requires skill, accessories, 
and the right settings. 
That’s not always easy to do with the stock 
Camera app, so here are some tips  
to improve your iPhone night photography.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
http://www.macsense.co.nz
https://www.appleworld.today/blog/2017/2/18/the-travel-series-apps-to-load-before-you-leave
https://www.appleworld.today/blog/2017/2/18/the-travel-series-apps-to-load-before-you-leave
http://appleinsider.com/articles/17/02/18/the-best-warhammer-40000-games-for-the-iphone-and-ipad
https://www.macobserver.com/columns-opinions/editorial/whos-more-intelligent-apple-siri-amazon-alexa
https://www.appleworld.today/blog/2017/2/15/apples-iphone-reclaims-top-position-in-global-smartphone-sales
https://www.appleworld.today/blog/2017/2/15/apples-iphone-reclaims-top-position-in-global-smartphone-sales
http://www.mac-nz.com
https://www.macobserver.com/tips/how-to/make-iphone-night-photography-stellar-tips
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apple&talk > 1-9-8-4

In 1984, Apple introduced the 
Macintosh – but had already been 
making computers since 1977. The 
ease of use and all-in-one form factor 
changed the computing industry, 
although the ‘real’ computer users 
scoffed. That said, the Mac didn’t 
really take off until the Desktop 
Publishing revolution happened a 
couple of years later.
In 2001, Apple introduced the iPod and 
dramatically revolutionised portable 
music. The hegemony of the iPod was 
only really broken by smartphones, 
which gradually became everyone’s 
default music vessels.

In 2007, Apple introduced the 
iPhone, which kicked off the 
smartphone revolution. Steve Jobs, in 
his announcement, hoped for just one 
percent of the worldwide mobile phone 
market share! That would have been 10 
million phones in 2008. Apple sold 4.7 
million iPhones in the first three months, 
but the first Android phones came out in 
November 2008, which has remained the 
only real competitor. In 2010, Jobs met with 
Google exec Eric Schmidt and threatened 
him over copying features for Android… 
Schmidt had been on Apple’s board.
Android had 43% of the smartphone 

market by mid 2011. Android’s share is 
now dominant, largely due to lower-price 
models, but it’s unlikely Apple will reduce 
prices since it’s just not the way the Inc 
works.
But this year, Apple releases it’s tenth 
anniversary model (nominally, iPhone 8) 
and already pundits reckon it will cost 
over US$1000 (about NZ$1400). This is 
really steep when you can get capable 
smartphones for a couple of hundred these 
days, so Apple had better make something 
pretty compelling for that price. NZ$1400 

makes me quail, frankly, and I need a 
new iPhone this year.

Apple is very different in 2017. 
iPhone changed everything after it 
was introduced in ’07, including Apple 
revenue which is now dramatically in 
the iPhone camp, but Apple was ‘like 
the wild west‘ ten years ago compared 
to its rigid structures and hierarchies 
in ’17. Back then, things were hard to 
control, but it also meant potentially 
crazy ideas could sometimes flourish.
Former Apple engineer Bob Burrough 
reckons Tim Cook has tried to eliminate 
executive conflict within Apple and 
grow middle management — but so 
doing, has crippled the Mac maker’s old 

spirit.
There does appear to be a lack of cohesion; 
Jobs’ megalomaniac vision certainly 
managed to focus things. Chinese 
telephonics and networking giant Hawaii 
reckons it can overtake Apple in 2018. 
Apple has some work to do, for sure. But 
on price? The cheapest iPhone Apple sells 
is the US$400 iPhone SE. Huawei’s least 
expensive smartphone retails for about 
US$50. Flooding the market with cheap 
always works, of course, but great is still 
great.
iPhone 8 needs to be really great.

mailto:mac.nz%40me.com?subject=From%20MagBytes
mailto:mac.nz%40me.com?subject=From%20MagBytes
https://www.theguardian.com/technology/2012/jan/24/smartphones-timeline
https://www.theguardian.com/technology/2012/jan/24/smartphones-timeline
http://appleinsider.com/articles/17/01/18/former-apple-engineer-says-company-more-rigid-less-competitive-under-tim-cook-than-steve-jobs
http://appleinsider.com/articles/17/01/18/former-apple-engineer-says-company-more-rigid-less-competitive-under-tim-cook-than-steve-jobs
http://appleinsider.com/articles/16/11/04/huawei-ceo-claims-company-can-overtake-apple-in-2018


>>

>
>

Mac NZ

page

10

‘MagBytes’, 
‘Mac NZ’, this 
document & all 
Intellectual  
Property 
Rights are all 
owned by Hip  
Enterprises/
Mark  
Webster 2015. 
Copyright 
Mark  
Webster/ 
Mac NZ/ 
Hip Enterprises 
2010-2015.  
No reprinting 
or republish-
ing without 
permission. 
For  
permission,   
email 
Mac NZ 

MagBytes
#84

apple&talk > Not on my watch (so far, anyway)

Is it time to admit Apple Watch is a 
success? Apple CEO Tim Cook has stated 
the last holiday period was the company’s 
“best quarter ever” for Apple Watch, 
both in units and revenues, “with holiday 
demand so strong that we couldn’t make 
enough.” 
Yet the tech community seems to think it’s 
not doing well, or even that it’s a failure.
John Gruber just thinks it should be 
considered a ‘watch’, rather than a 
‘smartwatch’. In September last year, 
Gruber points out, Apple Watch sales were 
second only to Rolex. Strangely, perhaps, 
when I tried the first version of the Apple 
Watch, what put me off was the lag in 
many operations. Once I had to send a unit 
back, I found the thing I missed the most 
was having the time on my wrist at all, so 
I went out and bought a watch which cost 
me just NZ$100 (about US$73). Couldn’t be 
happier.
But I never got to try the second version 
of the Watch (Series 2), so I never got to 
compare. Which at least spared me from 
spending another few hundred dollars on 
something with an Apple logo on it. What 
did impress me was superb build quality 
and very clever design, I loved being able 
to choose my Watch faces, and I loved the 
wonderful ease of changing straps – still a 
finicky mission on a normal watch.

I figured I would have got used to all the 
great features if it wasn’t for those little 
lags that, eventually, stopped me even 
trying to do things, although I understand 
the latest versions are significantly faster, 
by up to 50%. 
But if you’re still not satisfied even after 
updating to watchOS 3, which also added 
speed enhancements, it is possible to speed 
a Watch up via various settings.

Series 2 has its own GPS which means you 
don’t have to have your iPhone on you 
to track fitness etc – this never actually 
bothered me as I cycle and walk with my 
iPhone in my pocket anyway.

But hey, I’m not wearing an Apple 
Watch. I’m wearing a Timex Weekender. 
What about you?
[Bill Bennet wrote similar sentiments.]
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> Some for iOS, including a Batman Easter Egg in Siri, & EarPodstips&tricks

1/ Siri has a LEGO Batman Easter 
Egg — Once these hidden little gems 
proliferated through Apple stuff but Steve 
Jobs banned them. But sometimes you 
find them, and they’re even more precious 
now that they’re so rare. Press-and-hold 
your iPhone’s Home button to activate Siri, 
and get your Batman on by saying ‘Hey, 
computer’  and Siri respond with bat-
appropriate comments. Cool huh?  
(This also works on Siri for Mac, by the 
way.)

2/ AirPods volume control is via Siri — 
Telling Siri to “increase/decrease volume” 
will set AirPods users at the nearest default 
volume level —0, 13, 25, 38, 50, 63, 75, 88 
and 100 percent.

3/ But you can add percentages — You 
can add percentages from 0 to 100 
percent onto the back of volume control 
commands. Granular changes within two 
percentage points are hardly noticeable, 
but tweaks above three points are 

surprisingly distinct.
For those who want greater control, Siri 
lets users set audio output volumes by 
percentage.
First, invoke Siri with a double tap on an 
AirPod, or say Hey Siri or long-press your 
iPhone/iPad Home button. Now say, “Set 
volume at 53 percent” or “lower volume to 
23 percent.” 
Apple’s virtual assistant is capable of 
understanding a number of command 
variations including “raise/lower volume,” 
“turn sound up/down,” and “increase/
decrease volume,” among others.

4/ What percentage are you at? To 
discover current listening levels, users can 
ask Siri, “What percent is the volume?” or 
“what is the volume?”

5/ Print PDFs from emails — There is 
another hidden feature in iOS – this one 
lets you print-to-PDF with any email. This 
doesn’t require a third-party app or another 
email client: you can do it inside Apple Mail 

with 3D Touch. Open Apple Mail on your 
iDevice (iPhone and iPad). Open the email 
you want to save. Tap the Reply button and 
a menu pops up with three options: Reply, 
Forward – and Print. Tap Print.
You’ll now see a screen where you can 
select a physical printer over Wi-Fi. But if 
you 3D Touch the email (press harder on 
the screen, a feature added from iPhone 6s 
and including the 7s), this message it will 
‘pop’ and add a Share button at bottom 
right which lets you Share the email to PDF. 
This works for single page emails and 
emails with multiple pages. 
It’s a great way to save email receipts or 
important emails from VIPs (below). 
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tips&tricks iOS photo markup, Portrait Mode, Zoom, 3D Touch

1/ Quickly mark up Photos on 
iPhone — The stock Photos app in 
iOS has a great tool for drawing 
perfect geometric figures on your 
photos. With Photos you can draw 
shapes freehand, and the software 
can determine what shape you 
are trying to draw and, at the 
lower part of the screen, offer two 
options: your original shape or what 
the photo app thinks you are trying 
to draw.
Access the markup options by 
tapping on the three lines with circles 
located at the bottom of the photo. Then 
tap on the circle with the three dots and 
choose Markup.
At the bottom there are options for colour 
selection, and below that four options: 
drawing a shape, lens magnification, 
overlaying text, and undo.
Choose the colour you want – the drawing 
tool should be selected and in blue. If not, 
tap on the drawing tool which looks like 
a marker drawing a line. Now draw the 
shape on the photo. If you draw a shape 
closely resembling something the app 
recognizes, then, at the bottom, you will 
be given two choices: your drawing or a 
well-defined shape the app thinks you are 
trying to draw.
If you tap on the box to the right, choosing 

the shape the app suggests, you will have 
a perfectly formed shape with handles 
to resize or shape it further. You can 
press on the shape and move it to place it 
somewhere different on the photo. When 
you are finished, simply tap on an open 
space on the photo. If you like what has 
been done with the photo, tap “done”; 
otherwise tap “cancel.”

2/ Portrait mode in iOS 10.1 on iPhone 7 
Plus — iPhone 7 Plus can utilise its Portrait 
mode, creating an effect known as bokeh 
where the background behind a subject is 
blurred automatically. Officially it’s still in 
beta but you can get some pretty decent 
results out of it.
Swipe across the photo modes to Portrait, 
then frame your shot. Your iPhone will tell 
you if you need to move further away or 

find more light.
Keep your composition as 
simple as possible, with your 
subject (living or inanimate) as 
clearly defined as possible to 
avoid blurring the wrong thing. 
Experiment with exposure levels 
by tapping on the screen then 
dragging up or down on the 
sun icon. This will make things 
brighter or darker.

3/ Digital zoom — If your phone 
doesn’t have a second physical lens for 
zooming, digital zoom is an option too, 
but this is inferior since it just enlarges 
and crops the photo. If you do want to use 
it, tap and hold on the zoom button then 
drag left or right. Just don’t expect super 
sharp results.

4/ Get up close with optical zoom — 
Zooming in with optical zoom on the 

(Image from 9 to 5 Mac)
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tips&tricks > iOS tips continued, and macOS tips that are of  real benefit

iPhone 7 Plus, which has two lenses, is 
easy: tap the 1x button above the shutter 
button and hey presto, you’re twice as 
close to your subject.
Keeping your phone steady is really 
important, but this model of iPhone 
is actually having its lens move so it’s 
a sharp, details zoom rather than the 
artificial result all the other iPhones get, 
as above.

5/ 3D touch shortcuts — Since iPhone 
6s, pressing harder on your screen gives 
you extra commands and abilities (this 
does not work on iPhone 6 and any iPhone 
before that).
Here are some good ones to learn:
When downloading an app, you’ll see its 
icon appear as a timer on the home screen. 
To prioritise a download, and put it to the 
front of the queue of all the apps currently 
being installed, 3D Touch (ie, press 
harder on) the icon and choose Prioritize 
Download.
One of the key uses for 3D Touch is 
to expand notifications and get more 
details without having to actually open 
them – if you do this on an Uber alert, 
you’ll get information on the driver’s 
current location, plus the option to send a 
message.
The iOS Control Center is packed with 

3D Touch shortcuts just waiting to be 
discovered and used, including one for 
the Flashlight icon, which lets you choose 
between three different levels of intensity 
for the light: low, medium, and high.
Do a hard press anywhere on the iOS 
keyboard and it greys out, which means 
you can then move your finger to adjust 
the position of the cursor in the text.
A shortlist of contacts you frequently 
communicate with appears with a 3D 
Touch on the Phone app icon.
With a light tap on a link in Safari you can 
get a preview of the page without actually 
navigating there. It’s one of the “peek and 
pop” uses of 3D Touch.

1/ Use Quick Look in macOS Sierra — Use 
Quick Look in macOS Sierra (and previous 
versions of macOS) to view photos, 
files, movies, sound files, PDFs, even 
Word files when you don’t have Word, 
without opening them – the view is in full 
resolution. You can use Quick Look for 
items in Finder windows, on your desktop, 
in emails, in messages, and other places. 
Select one or more items, then press the 
Spacebar on your keyboard or, with later 
apple trackpads, force-click items. A 
Quick Look window opens. If you selected 
multiple items, the first item is shown. 

You can manually enlarge the window by 
dragging its corners, click the Full Screen 
green button at top left, and to return to 
the previous size, click the Exit Full Screen 
button (that green button again).
To see the next or previous item, click 
the arrows on the left, or press the Left 
and Right arrow keys. In full screen, you 
can click Play to view multiple items as a 
slideshow.
To see the items in an index sheet view, 
click the Sheet View button on the left, or 
press Command-Return.
You can also open the file with its parent 
Application, which is listed at top right, 
to actually edit the file (in the example 
above, it’s the Preview app) and click the 
Share button on the right.
When you’re done, close the Quick Look 
window by pressing the Spacebar or force-
clicking again, or click the Close button 
(red button at top left of the window).
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tips&tricks > Some more logical smartness for macOS Finder

2/ Play the video portion of a Live Photo 
— When you open a Live Photo (which you 
can only take with iPhone 6s or 7) in the 
Quick Look window, the video portion of 
the photo plays automatically. To view it 
again, click Live Photo in the bottom-left 
corner of the photo.

3/ Create and modify a Smart Folder 
— Smart Folders automatically gather 
files by type and subject matter. They’re 
updated as you change, add, and remove 
files on your Mac.
In the Finder, choose File>New Smart 
Folder. To search for files, enter a topic, a 
phrase, or another parameter in the search 
field.
To determine whether the search should 
include only the names of files or their 
entire contents, choose ‘Name matches’ in 
the search suggestions that appear below 
the search field, then click Name, then 
choose either Filename or Everything.
To search for additional specific attributes, 
click the Add button below the search 
field, then make choices using the search 

attribute pop-up menus that appear.
The menus work in pairs; for example, to 
search for images, you choose Kind from 
the pop-up menu on the left, then choose 
Images from the pop-up menu next to it.
Click Save, then specify a name and 
location for your Smart Folder.

If you don’t want your 
Smart Folder to be in the 
sidebar, deselect Add To 
Sidebar.
You can’t use certain 
characters, 
including 

punctuation such as a colon 
(:), in folder names. If an 
error message appears, try 
using another name.
To change the criteria for 
a Smart Folder, open the Smart Folder. 
Begin typing in the folder’s search field, 
or click the Action pop-up menu , then 
choose Show Search Criteria.

4/ History in Safari — Want to see the 
sites you were looking at on your Mac 
yesterday? Easy. From the History menu, 
you can choose Earlier Today, or any of the 
six days preceding that.
Of course, this poses a security concern: 
anyone else can do the same thing on your 
Mac if it’s unlocked, to see where you were 

and to open any of those links – you’re 
bank account, for example, and if you let 
this automatically log in (a very bad idea), 
then you’re really asking for trouble. When 
you select the Clear History item at the 
bottom of the History menu, you get to 
choose just to delete the last hour’s sites, 
Today, Today and Yesterday or All. Be 
warned that any logins and auto-logins 
you went to will also be ‘forgotten’ and 
you will have to enter your details and/or 
auto- log in again.

5/ Selectively delete history items — I 
had never realised you can much more 
selectively delete history items. When you 
choose Show All History, which is the very 
top item in the History menu, you get to 
click on any one item (or hold down the 
Command key on your keyboard to select 
several items) to highlight individual sites 
and press the Delete key on your keyboard.
You can clear everything with the Clear 
History …’ button and even search for that 
distant item.
Double-clicking on any line launches the 
site, which can also be very handy.
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tips&tricks > More Finder tips to help you wrest back control of  Mac behaviour

1/ Set the view in the macOS Sierra 
Finder — The Finder in macOS Sierra offers 
four ways to view items in a window: List, 
Columns, Cover Flow and Icon. To choose 
a view, click your preferred View button at 
top-left of any Finder window.
In Icon view, each file or folder is 
represented by an icon (such as the Mac 
desktop). List view shows details about a 
file or folder, including its attributes.
Column view provides a visual trail 
of where you’ve been, and displays a 
hierarchical view of where a file is stored. 
Cover Flow is a modified list view that 
displays a thumbnail view of a file’s 
contents, which is great for folders of 
photographs, for example.

2/ Button descriptions — Turn on the 
descriptions for Finder window buttons. 
With a Finder window on the desktop, hold 
down the Control key on your keyboard 
and click in the grey area at the top of the 
Finder window just to the left or right of 
the folder’s file name at top centre. From 
the pop-out that appears, choose Icon and 
Text, and all your buttons get labels (it’s 
worth trying this in other apps like Apple 
Mail and Preview).
Choosing ‘Customize Toolbar’ [sic, and 
shown above] lets you even select which 
icons appear in the top area of Finder 

windows at all, and also get rid of any you 
don’t require.

3/ More view customisation — There are 
additional ways to customise how your 
items are displayed: sort items, arrange 
icons, and resize columns. Settings for 
sorting and arranging items in a folder 
apply until you change them. For example, 
if you sort your Documents folder by 
Date Added, the next time you view your 
Documents folder, it will also be sorted by 
Date Added.
To sort items in any view, from the View 
menu in Finder select Show View Options. 
Now click the Sort By pop-up menu and 
choose the sort order: Date Modified, 
Name etc.
In List view and Cover Flow, move the 
pointer over the column name you want to 
sort by, then click it. Click the column name 
again to reverse the sort order.

4/ Arrange — To arrange items in Finder 
windows in any view, click the Item 
Arrangement button, then choose an 
option, such as Date Created or Size.
When arranging by name, you can keep 
folders (in alphabetical order) at the top of 
the list. Choose Finder>Preferences, click 
Advanced, then select the “Keep folders on 
top when sorting by name” checkbox.

5/ Resize columns — In List view, Column 
view, and Cover Flow, drag the hairline 
divider between the column headings at 
the top of the window, ie between Name 
and Date Modified.
To expand a column to show all filenames 
in their entirety, double-click the column 
divider. Control-click (hold down the 
Control key on your keyboard and click) 
any column to view all columns available. 
Choose a column name to display or hide it 
(visible columns have a checkmark next to 
their name).

More — You can change the text size of file 
names and, in some views, change the size 
of file icons. Open a Finder window, select 
the folder you want to change, then click a 
View button: Icon, List, Column, or Cover 
Flow.
Have the folder always open in this view by 
selecting the ‘Always open in’ checkbox to 
set specific preferences for specific folders. 
To have subfolders also open in this view, 
select the ‘Browse in’ checkbox.
If a subfolder opens in a different view, 
select the subfolder, choose View>Show 
View Options, then deselect the ‘Always 
open in’ and ‘Browse in’ checkboxes. The 
checkboxes must be selected for the main 
folder and deselected for the subfolder.
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shiny&new Editors Keys make editing ~ Protect everything ~ Better photos

Editors Keys protect & instruct
Fitting silicone keyboard covers protect 
and sound-deaden keyboard clacks while 
marking specialist key shortcuts for a wide 
range of programs including Pro Tools, 
Logic, Cubase, Avid, Premiere, Photoshop 
and more… from US$29.85 up, online 
sales, shipped from the UK. 
While there, check 
out their other gear!

Take Better Photos for 99¢
First in the series of CreativeTech 
quickguides in iBooks is short, clear and 
super-instructive book. Just click this 
link, then Get Sample for a sample, or 
click on the price to buy it. 
Install once for multiple devices on the 
same Apple ID. 

Extra protection from Norton Security Premium
How times have changed. Now you can get one installation that 
protects not just a Windows PC with its long-proven susceptibility 
to malware, but also a Mac (macOS and the previous two versions) 

iPhone (iOS 7 and later) 
and Android, all from one 
pack. 
You buy a product key 
pack (as pictured), go to 
a website, enter the key 
code enclosed in the pack, 
follow the on-screen 
instructions and  voila. 
The five-license version 
pictured currently costs 
NZ$99.99 (discounted 
from $169.99 for five years’ 
coverage); the three-
license pack is $79.99, and 
for one device $59.99 from 
retailers including Noel 
Leeming.
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